TRI-ME Desktop

Tutorial
Getting Started with TRI-ME

This tutorial has an audio component. Please adjust
w))speakers. For audio script, please download the TRI-ME
Tutorial PowerPoint presentation.


Presenter
Presentation Notes
Welcome to the TRI-ME “Getting Started” Tutorial.  This tutorial will help you install the TRI-ME software and take the first steps towards completing your TRI forms.
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Presenter
Presentation Notes
To install the TRI-ME software, insert the CD into your CD drive and the TRI Reporting Software overview window will automatically open.  You can use the tabs provided to learn more about the TRI software.  When you are ready to install TRI-ME, click “Install”. 
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Presenter
Presentation Notes
From the install screen, select the “TRI Software” option.  This launches the TRI Reporting Software installation application.






«_l-—;!.- License Agreement ﬂ

Fleaze read the fallowing license agreement

Inztallation Dizclaimer far TRI-ME -

The Toxics Releaze Inventory Made Easy [TRI-ME] zoftware iz
intended ta help users understand and comply with the reporting
requirements of gection 31.3 of the Emergency Planning and
Community Right-to-Fnow &ct [EPCRA). TRI-ME BY 2005 contains
guidance applicable far reparting vear 2005,

T accomplish the goal of helping uzers understand and comply

with the reparting requirements of Section 313 TRI-ME packages a

range af the Environmental Pratection Agency's [EPA] EPCRA

guidance in one convenient saftware program. | sers can either

access the available guidance and requlatory requirements

directy. or through the uze of the interactive questionnaire

portion of the program.  To effectively uze TRI-ME, the uszer iz ;I

By clicking the "'l &gree” below, vou agree to be bound by all the terms and conditions of
the abowe End User Licensze Agreement. [ vou do not agree with any of the terms and
conditionz click "Cancel”.

Cancel |



Presenter
Presentation Notes
Before proceeding to install TRI-ME, you must accept the license agreement.  After clicking “I agree” follow the instructions provided to install the software.  After the installation is complete, you will need to re-start your computer.  






Downloading from the Web:

www/epa.gov/tri


Presenter
Presentation Notes
If you do not have a Reporting Year 2005 TRI Reporting Software CD, you can download the TRI Reporting Software installation application from the TRI Program Web site at www.epa.gov/tri.  
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Search: |

Reporting Year 2004 Toxics Release

Inventory (TRI) Electronic Facility
Data Release (e-FDR)

Burden Reduction Proposed Rule

(Phase II)
|The comment period for the TRI Burden Reduction
|Proposed Rule has been extended to January 13,

2006

|Comments may be submitted in a number of ways as
|described in the Federal Register notice. One new
[feature is that comments may be submitted on-line
{using the following new Federal Government portal:
|www_regulations.gov. Use the keyword, “toxics release
{inventory”™.

Public Notice Announcing EPA's
intention to initiate a rulemaking
to modify the frequency of

reporting under the TRI program.

|Federal Register Maotice (TEXT) (PDE, 1.64MB, 6pp,
|About PDF)

|Eact Sheet Describing Both of the Above Actions
|(PDF, 38KB, 2pp, About PDF)

|Press Release Describing Both of the Above Actions

@
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Presentation Notes
Select the “Download TRI-ME software” link on the left-hand side of the screen and follow the download instructions provided.
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Presenter
Presentation Notes
After re-starting your computer, you will notice two additional icons have been added to your desktop that enable you to open the TRI Reporting Software [Animation Note: highlight the desktop icons].  One is for the TRI Assistance Library and the other is for the TRI-ME RY2005 software.  You may also open these applications by using the Start menu, selecting “Programs”, and locating the “TRI-ME RY2005” program group. 








Welcome to TRI-ME

As this is the first time you are using TRI-ME after loading the software you need to name a file. Ve
suggestyvou use a file name that describes the facility for which you are using TRI-ME. Please note
that if you plan to report for more than one facility using TRI-ME, then you must create a separate file for
each facility. You can create additional files at any time by simply using the File pull-dosen menu
[ocated in the upper left corner of this screen.

TRI-ME will automatically open to the last file worked on prior to exiting TRI-ME. You can use the File
pull-dosven menu to open any ather file.

FPlease enter a file name far the data being entered far your
facility and then click the Continue button below:.

Continue |



Presenter
Presentation Notes
The first time you open the TRI-ME application, you are prompted to enter a Facility File Name.  A TRI-ME facility file is a file that is saved on your computer that stores all of the data you enter for a given facility.  It is recommended that the facility name you choose is descriptive of the facility and the current reporting year.  Please do not use any characters in the file name other than numbers and letters.

After entering a facility file name, click Continue.
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Expert User v Click on the link below to see if there o= pogam
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reshold v have been any updates to this version

T & of TRI-ME, any revisions to the Sl
I guidance documents or other
i changes that might impact the TRI
Part, Facilty reports that are due July 1, 2006.
Fart |, Chemical
FPart I, Section 1
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Section 3
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Presenter
Presentation Notes
If you are starting up TRI-ME for the first time, you will be prompted to check an EPA web site to see if any software updates, guidance revisions, or other changes have occurred that might impact your TRI reporting.  Click “OK” to close this window  
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Fart |, Facility
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FPart I, Section 1
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Are you a ne
the new TRI

2 &2 |-

= Hotline Support. ..

Welcome to ] ]EI Check for TRI Updates., .
that uses you
you fill out the

0 Important Information for RY2004

2 Inventory Made Easy

State Information

Aszsistance Librany

i Acknowledgements. ..
About TRI-ME. ..

Lets get started!

More on TRI

nd easy way to report! TR-WE is an interactive program
determine if you need to report and, if so, TRI-WE helps

n learning more about TRI-ME features? Check out
ittp:/ ey, e pa. gov/tri‘re port/trime/tutorials

N

What important information do | need to review

for the 2005 Reporting Year?

More on PBT Chemicals

More on Lead Reporting
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Presenter
Presentation Notes
This reminder will re-appear periodically, however you can check for updates at any time by selecting “Check for TRI Updates…” from the help menu.




m ES Important Information for Reporting Year 20051

File Ed

[Threshold

Facility

Ermploy
Chemic
Chemical

v
g TRI-

Go B

200000,

Please review the following important information for Reporting Year (RY) 20035.
Internet Beporting via CDX

EPA encourages you to use TRI-ME to submit reports through the Internet via EPA's Central Data Exchange (COX). TRI-ME no
longer supports the submission of paper forms to WS, EPA (zee below].

You may use COX even if this year is your first time submitting TRI formz. The TRI-ME software will help you through the DX
submizsion process, Additionally, it your state iz a paricipant the the State Data Exchange program you SO submission to U.S.
EPA wyill be automatically forwarded to yvour state, satisfyving your need to submit to your state.

TBI-ME BY2005 Software Changes

Mew! TRI-ME Tutorials are novy svailable to help learn more about TRI-ME and its features! Check them out at:
[http: £ /www_epa qov/trifreport/trimeftutonalz]

MNewl For Reporting Year 2005, the TRI-ME saftwware will no longer suppart the ability to print federal paper submizsions. This
means that facilties will no longer be able to uze the TRI-ME zoftware and then print paper submiszions for federal reporting
purpozes. Howewver, TRI-ME wvill continue to suppott the akility to print paper file copies and state paper submizsions.

Regulatory and Guidance Changes

Mew! Methyl Bthyl Ketone (MEK) Delisting. Facilties are no longer required to repart MEK because of a
court order removing MEK from the TR

Mew! rumerous changes to the Form B and Form & have been maded in BY 2005 a2 a result of the TRI
Reporting Forms Modification RBule (39931 Federal Register £ %al. 70, Mo, 132, Tuesday, July 12,
2005, Changes include, but are not limited to the deletion of Sections 4.6 4.8 4.9 and 410 in Part 1
of the Formz R and &, simplifications to Part 2 Section ¥ of the Form B, and the introduction of an
optional text box in Part 2 Section 5.11 of the Farm .

A more detailed discussion of each of these topics - and others - is provided in the BY2005 TRI Reporting
Forms and Instructions.

Bead More_._.

] Dan't shows this window on stark-up. vou may view thiz infarmation at any time by zelecting "lmporkant [nformation for
R 2005" from the TRI-ME Help menu.

ut
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Presenter
Presentation Notes
You will also receive a window outlining some important information for the current reporting year.  Click “OK” to close this window.  If you do not wish to have this window appear each time that you start TRI-ME, select the box at the bottom left of the screen. 
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Presenter
Presentation Notes
You can return to this “Important Information” screen at any time from the Help menu.
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Welcome to TRI - Made Easy (TRIHME) - the fast and easy way to report! TRISWE is an interactive program
that uses your answers to a series of questions to determine if you need to report and, if so, TRI-ME helps
you fill out the appropriate reporting forms.

Are you a new TRI-ME user, or just interested in learning more about TRI-ME features? Check out
the new TRI-ME Tutorials! Available on-line at: http://www.epa.gov/tri‘report/trime/tutorials

More on TRI

2 &2 |-

Lets get started!

N

What important information do | need to review
for the 2005 Reporting Year?

More on PBT Chemicals

More on Lead Reporting
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Presenter
Presentation Notes
Note that the name and location of the TRI-ME facility file that you are currently working with is displayed at the top of the window [Animation Note: highlight the application title bar].  If you need to prepare forms for more than one facility, use the “File” menu to create a new TRI-ME facility file.
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Part], Chernical =] Dst1.mdb Dsz3.mdb teasdf.mdb
Fart Il Section 1 =] Ds12.mdb Ds24.1.mdb test.mdb
Section 2 =] Ds13.mdb Ds3.mdb test1.mdb
Section 3
1| v
Section 4 : _I
"‘““““":"', 4 File narme: I Open I ;I
TRI-ME Help Files of tpe: | TRIME Databases [*mdb) Cancel |
e
u Go Back
i More on TRI ﬁl More on Lead Reporting
i What important information do | need to review
for the 2005 Reporting Year?
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Presenter
Presentation Notes
In the “New Facility File” dialogue box, enter the name of the new TRI-ME facility file and click “open”.
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Welcome to TRI - Made Easy (TRIHME) - the fast and easy way to report! TRISWE is an interactive program
that uses your answers to a series of questions to determine if you need to report and, if so, TRI-ME helps
you fill out the appropriate reporting forms.

Are you a new TRI-ME user, or just interested in learning more about TRI-ME features? Check out
the new TRI-ME Tutorials! Available on-line at: http://www.epa.gov/tri‘report/trime/tutorials

More on TRI

2 &2 |-

Lets get started!

N

What important information do | need to review
for the 2005 Reporting Year?

More on PBT Chemicals

More on Lead Reporting

{GAZ000001001

[

MU | |

15


Presenter
Presentation Notes
Note that the name and location of the new TRI-ME facility file is displayed at the top of the window.  If you wish to move between these facility files, use the “File” menu to open a different TRI-ME facility file.
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Presenter
Presentation Notes
In the “Open Facility File” dialogue box, select the desired TRI-ME facility file and click “open”.
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Lets get started!

More on TRI

N

What important information do | need to review
for the 2005 Reporting Year?

2 &2 |-

More on PBT Chemicals

More on Lead Reporting

I ! Faciify:

art Here ] ] ] LI
Expert User Welcome to TRI - Made Easy [TR.‘-_.‘&] - the fast and Easy way to report! TRI-WE is an interactive prograrm
e that uses your answers to a series of questions to determine if you need to report and, if so, TRI-ME helps

S — you fill out the appropriate reporting forms.

Facility Are you a new TRI-ME user, or just interested in learning more about TRI-ME features? Check out

Employee the new TRI-ME Tutorials! Available on-line at: http://www.epa.gov/tri‘report/trime/tutorials

Chermical
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Presenter
Presentation Notes
Again, note that the name and location of the new TRI-ME facility file is displayed at the top of the window.  

After creating the TRI-ME facility files that you need, you are ready to begin.  If you are uncertain if you need to report you can use the “Threshold Determination” portion of the software to assist you in determining if you need to report and for what chemicals.  To do so, click on “Threshold” in the navigation column.
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Fil= Edit Tools
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Toxics Release Inventory Made Easy
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Expert User
Load Drata
Threshold

Facility

Employee

Chemical
Chemical Select
Form Select
Revisiohs
Fart |, Facility
Fart |, Chemical
Partll, Section 1
Section 2
Section 3
Section 4
Section 5.1

v

To be required to file a TRI report, you must meet three criteria:

1. ¥our facility must be in a covered Standard Industrial Classification (S1C) Code or your facility is a federal
facility; and

2. Your facility must meet the employee threshold; and

3. Your facility must exceed a chemical activity threshold,

TRI-ME Help
n Go Back

> | Continue with Questionhaire

(GAZ000029001
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Presenter
Presentation Notes
TRI-ME will prompt you for the information needed to determine your reporting obligation.  Provide all information requested and use the navigation buttons at the bottom of the screen to move through the questionnaire.  Note that this is an optional feature of TRI-ME. 
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Are you a new TRI-ME user, or just interested in learning more about TRI-ME features? Check out
the new TRI-ME Tutorials! Available on-line at: http://www.epa.gov/tri‘report/trime/tutorials

Lets get started!

More on TRI

What important information do | need to review
for the 2005 Reporting Year?
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More on PBT Chemicals

More on Lead Reporting
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Presenter
Presentation Notes
If you already know that you need to report for one or more chemicals and have prior year data that you would like to load, you should load your data before proceeding.  Loading data will save you the trouble of re-entering the majority of your form data that has not changed from last year.  A separate “Load Data” tutorial is provided that describes this process.  If you are preparing forms for multiple facilities, you will need to repeat the “Load Data” process for each TRI-ME facility file.  After successfully loading data, you will be able to complete data entry of your forms.  

If you do not have prior year data to load, you must create new, blank forms.

If you already know that you need to report for one or more chemicals but do not have prior year data to load, you must create new, blank forms.  To do so, click “Expert User” in the navigation column.
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Chermical
Chemical Select

Fart |, Facility
Fart |, Chemical
Fart I, Section 1
Section 2
Section 3

Section 4
Cartinm 51

TRI-ME Help
n Go Back

TRIMME provides two different data entry methods for you to use:

1. Questionnaire

Using the Questionnaire method, TRSWE will ask you guestions in plain English and use your responses to
1) determine if you need to report and 21 prepare the requisite forms. Please select the "Continue” option
below to begin the questionnaire.

2. Forms Completion
Following the threshold determination portions of the Questionnaire, you may elect to click on the Form A or
R tab and fill therm out directly.

Are you an Expert User? If you are an experienced TR reparter, you may wish to begin completing your
Farms immediately, without using the threshold determination portions of the Questionnaire. If so, select that
you are an "Expert User” using the button below. After collecting your primary SIC code and the TR
chemicals ar chemical categories you wish to report on, TRISWE will allow you to complete your Forms. By
selecting that you are an Expert User, you are indicating that you do not need TRI-WE's assistance in
determining that your facility is subject to each of the EPCRA section 313 reporting requirements i.e., total
number of employees, primary SIC code, and chemical activity threshaold quantities).

=l
Continue

| want more information on how TRI-ME works

| am an Expert User

(42000001003
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2869 Industrial Organic Chemicalz, MEC Y :
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Fartl, Chemical 2674 Phosphatic Ferilizers

Fart I, Section 1 2873 Fertilizers, Mixing Cnly j
Saction 2 28748 Pesticides and Agricuttural Chemicals, MEC _I

' 28 Adhesives and Sealarts .
Section 3 .
) 2892 Explosives
Section 4 2893 Prirting Ink _ILI
Ctactinm & 1 a | » | | 4
v
TRI-ME Help Continue

n Go Back

| 2
% | arm not certain - | need more help
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Chetmical already loaded data into Form B oor Form A Certification Staterment renorts for this renorting vear. For other x
Chemical Select Threshold Reparting
Form Select Erceeded TRl Chemical ar Chemical Categony Faor BY2005 Report Dant
Revisions M/D 1.1,1,2-Tetrachloro-2-fluoroethans Chemical Report
- Chemical
Fart |, Facility Add
Fart|, Chemical Chemicalz
; Far
Fart ll_. Section 1 - Repart All Chemicals
Section 2
Sectiun 3 Feport Only Chemicalz
Section 4 Exceeding Threshald
Coctinkn & 1
TRI-ME Help p | Contihue
nGu Back _—
% | arm not certain - | need more help
QAELI0N0NO004 T
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'E;!_f TRI-ME RYZ005 - [TRI MADE EASY

File Edit Tools Reports Help

Facility File: C:\ TRI-ME'RY 2005 TRI Software",Dat

=loix|
== x|

Questionnaire

Faciiity:

Toxics Release Inventory Made Easy

State Information

Asszistance Library

hreshald

Please note that in order to submit a Form A cerification statement cerain criteria must be met;

- Toxic chemical

must be a non-PET listed chemical;

el - Facility must have manufactured, processed, or otherwise used 1,000,000 or LESS pounds of the non-
Employee PET listed chemical during the reparting year, and |
Chemical - . . . .
. Flease indicate for which chemicals you would like to complete Form A instead of Form R =
Chemical Select
Form Select Chemical Name FormR Form A
Fevisions
1,1,1,2-Tetrachloro-2-fluoraethane c o
Fart |, Facility Y
Fartl, Chemical Abhamectin = -
Fart I, Section 1 ) -
S Benzamide 5
Section 32 -
Section 4 [
Coctinkn & 1
TRI-ME Help p | GotoFormR
nGu Back
% Go to Form A
[QAELIOD0ODN0S [ T o[
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¥ TRI-ME RYZ005 - [TRI MADE EASY  Facility File: C:\ TRI-ME,RY¥2005%, TRI Software’, N =l
File Edit Tools Reports Help

=151x|

<EPA

Toxics Release Inventory Made Easy

Questionnaire State Information Asszistance Library

Faciiity:

Start Here
Expert Lser
Load Data
Threshold
Facility
Employee
Chemical
| Chemical Select
| Fortn Select
| Fevisions
Part I, Facilrty
FPartl, Chemical
FPartIl, Section 1
Section 2
Section 3

Section 4
Cortinn & 1

TRI-ME Help
n Go Back

YWelcome to the Forms Completion section of TRI Made Easy!

By arriving at this section, you have determined that you meet the reporting criteria for at least one toxic
chemical. This means that your facility is required to subrmit either a Form R or, under special
circumstances, a Form A Certification Staternent, for each toxic chemical subject to reporting. Remermber, at
any time, you can go directly to the Forms folder and complete the appropriate forms. For now, TRISHE will
walk you through Form R, There are two parts to the Form R Part |is generally a facility specific section that
will be the same for all of the EPCRA Section 313 reports you subrit. Part |l is chemical-specific and will be
different for each report.

TRI-ME will start with Part |, where you will need to enter some information that is specific to the facility.
Once you have provided information about your facility or confirmed loaded information, this program will ask
you guestions about each of the toxic chemicals for which you are required to report.

Continue with Questionhaire
Additional Information on the Form R

Maore on Form A Certification Statement

\GE1000001001

N O 1
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End of TRI-ME Tutorial

Getting Started

Click the Menu button to go to the TRI-ME Tutorial Topics Menu to
select to view another tutorial.
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Presenter
Presentation Notes
Congratulations, you have now completed the Getting Started Tutorial.



To view additional tutorials, click on the “Menu” button to go to the list of TRI-ME Tutorial Topics.
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